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PROTOCOL FOR MEASURING
SMALL MOLECULE INTERACTIONS

USING BIACORE

A Practical Guide
to Experimental Design
and Data Evaluation
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1. PREPARATION

A successful small molecule assay on the Biacore requires careful preparation of running
buffer, instrument, sensor surface, and samples.  The process of setting up a small
molecule assay follows the same general procedure (immobilization, binding, and
regeneration) for all Biacore applications.  Some of the steps may be more or less time
consuming depending on how much is known about the ligand and the small molecules.

General Considerations
All buffers used in the assay both as running buffer and for sample and reagent
preparation, should be filtered through a 0.22µ filter and degassed.  Use Teflon or nylon
filters for buffers containing DMSO: do not use cellulose acetate filters. Also avoid
polystyrene containers for holding the buffer; glass bottles are recommended.  Phosphate
buffered saline (PBS) is recommended as a buffer for most small molecule assays. Many
different “standard” recipes are available for PBS and any of these are acceptable. Keep
the phosphate concentration at 50 mM or higher to maintain sufficient buffering capacity
to handle addition of DMSO to the buffer without seriously affecting the pH.  Use ionic
strength at or close to physiological levels (150 mM monovalent ions) to reduce non-
specific binding of compounds to the sensor surface.

Other buffers may be used if required by the application however, organic buffers such as
Hepes are not generally recommended, since they have been observed to interfere with
ligands binding human serum albumin (HSA).

Make sure the buffer is compatible with other solutions used in the assay, in particular
with regeneration solutions.  Certain ligands (for example thrombin) are efficiently
regenerated with 4 M MgCl2, which can cause precipitation at the injection interface
between regeneration solution and phosphate-based running buffer. Alternative buffers
must be used in such cases.

Solvents
Many small molecules require organic solvents for solubility. Dimethyl sulfoxide
(DMSO) is most commonly used: a recommended concentration for Biacore assays is
5%, however this will depend on the activity of the target or ligand in the presence of
DMSO. The instrument fluidics can withstand concentrations up to 50% for short
injections, for example for washing the flow system.

The running buffer should contain the same DMSO concentration as the samples, since
DMSO is has a high refractive index contribution and small differences in DMSO
concentration will significantly effect the bulk response.  Match the DMSO concentration
between samples and running buffer as closely as possible. A 1% difference in DMSO
concentration can result in a 1000 RU bulk shift.
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When handling DMSO, particularly in concentrated form, make sure that all vessels and
equipment withstand contact with the solvent.  Certain plastics (polycarbonate and
polysulfone) release contaminants into DMSO that have been observed to bind HSA and
interfere with binding assays on the Biacore.  Deterioration of the plastic on contact with
DMSO is not always apparent.  Running test analyses with negative controls (buffer
containing DMSO) is recommended for all assays.

DMSO is incompatible with polycarbonate and polysulfone, moderately compatible with
polystyrene and compatible with polypropylene.

DMSO from different suppliers may vary in quality, and may sometimes contain
contaminants that interfere with the assay.  Good results have been obtained using DMSO
from Sigma (D 5879).
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1.1 Buffer Preparation

Prepare 1X PBS running buffer as follows:

1. Prepare a 10X concentrate of 67 mM Na2HPO4•2H20, 12.5 mM KH2PO4, 70 mM
NaCl and pH the solution with concentrated HCl according to the chart below so that
the final pH is 7.4 when the 10X stock is diluted to 1X.

pH table for 10X PBS

%DMSO in final 1X buffer pH of 10X PBS pH of 1X PBS

1 6.65 7.4
3 6.80 7.4
5 6.85 7.4
7 6.90 7.4
10 7.00 7.4

1X PBS (no DMSO); running buffer during immobilization
2. Add 50mL of 10X PBS to 450mL of H20. Filter and degas. Set aside for

immobilization procedure.
1X PBS (5% DMSO); running buffer during binding assay
3. Add 50mL of 10X PBS to 425mL of H20. Add 25mL of DMSO (HPLC grade) to

give ~5% DMSO 1X PBS, pH 7.4. Filter and degas. This will be the running buffer
for the binding experiment.

1.05X PBS (no DMSO) for sample preparation
4. Add 52.5mL of 10X PBS to 447.5mL of H20. Filter and degas. Set aside for sample

preparation and dilutions.

Tips:
_ Make up fresh 1X PBS every day.
_ Avoid polystyrene containers; use clean glass bottles for buffer.
_ Use Teflon or nylon filters for buffers containing DMSO: do not use cellulose acetate
filters.
_ Always keep buffers in clean bottles tightly capped before placing in the Biacore.
_ When the buffer is placed in the buffer compartment of the Biacore, keep the cap
screwed down to prevent any evaporation or contamination of the buffer.



Workshop Series – Strategies for Working with Small Molecules

Biacore Symposium 2002, Chicago, I llinois                                                              Page 5 of 17

1.2 Instrument Preparation

In view of the low responses obtained from low molecular weight small molecules, it is
essential for reliable results that the Biacore system is properly maintained at all times.
To improve data quality, run the following cleaning procedure before every small
molecule assay:

1. Set instrument temperature to 25°C.
2. Dock a clean maintenance chip.
3. Place distilled water in the buffer chamber and prime.
4. Run DESORB.
5. Prime 2X with water.

Automated Method for cleaning:
MAIN
PRIME
DESORB R2F3 R2F4
PRIME
PRIME
APPEND STANDBY
END

6. Dock a new CM5 research grade sensor chip.
7. Prime 3X with the 1X PBS running buffer (no DMSO).
8. Pre-condition the sensor chip as follows:

• Set flow rate to 100 µL/min.
• Using the QUICKINJECT command, apply 2 consecutive 50 µL pulses of each of
the following reagents: 50 mM NaOH, then 10 mM HCl, 0.1% SDS, and 0.085%
H3PO4.
• Wash the IFC at the end of the injection series. (Go to command then wash)
• Inject blank buffer to wash out any remaining cleaning solutions in the autosampler
tubing.

Tips for improving data quality:
_ Check syringe plungers for debris and leaking.
_ If needed, clean syringes and replace o-rings on the plungers as directed under working
tools.
_ Remove and clean connector block with distilled water then replace and check injection
port.
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1.3 Surface Preparation

General Considerations
The target protein (ligand) should be immobilized to a high level under as mild pH
conditions as possible. Performing the immobilization at pH 6 vs. pH 4 may be better
even if it means using 100µg/ml of the target protein instead of 10µg/ml.  Immobilizing
at a pH closer to the pI of a protein helps to ensure a more active form of the protein in
being immobilized.  To estimate how much protein needs to be immobilized, calculate
the theoretical maximum response, Rmax, achievable when the lowest molecular weight
compound under investigation binds to the protein. Theoretical Rmax values of at least
30 are preferable. As an example, to achieve a theoretical Rmax of 50 RU when a 358 Da
compound binds to a 40 kDa target protein, the immobilization level required is
calculated as follows:

Rmax = MWA/MWL x RL x SM

Where MWA is the molecular weight of the analyte
MWL is the molecular weight of the ligand
RL is the immobilization level in RU
SM is the molar stoichiometry

   50 = 358/40,000 x RL x 1

   RL = 40,000/358 x 50

   RL = 5586 RU

However, if the surface were only 50% active then 11,172 RU would need to be
immobilized:

50% activity: 5586/0.5 = 11,172 RU

Reference Surface Considerations
The use of a reference surface enables subtraction of bulk responses. The dextran matrix
of a reference, without any immobilized protein, will have room for slightly more DMSO
than when target is immobilized. A higher DMSO bulk response will then be obtained
from the empty flowcell compared to the target flowcell during injection. Thus the
response may be higher on the reference surface than the target surface.  To correct for
this difference a solvent correction assay can be performed. (Section 2).
Either unmodified or an activated and blocked dextran surface can be used as a reference
surface. Which to choose depends on the properties of the compounds and their
susceptibility to bind non-specifically to the modified/unmodified dextran.
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1.4 Testing the Surface

Once the surface has been prepared, the analyte binding activity should be tested before
proceeding to further stages in assay development. The same protocol can also be used to
test the activity of sensor chips that have been stored, to ensure that activity is retained.

To test the binding activity of the surface, a known binder should be used as analyte. If
the analyte is a small molecule that requires DMSO for solubility, include the same
concentration of DMSO in the running buffer to minimize the bulk refractive index shift
during sample injection.

1.5 Preparation of Samples

50 µM is a suitable concentration to start with when sample binding levels are unknown.

To prepare a 50 µM stock sample in 5% DMSO: Add 5 µl of a 10 mM stock
concentration in 100% DMSO to 995 µl of 1.05X PBS no DMSO.

Serial dilutions can be made from the 50 µM stock using the 1X PBS with 5% DMSO
(running buffer) as the diluent.

Prepare 25 µM sample by adding 500 µl the 50 µM stock to 500 µl of the 1X PBS with
5% DMSO (running buffer).
The next dilution (12.5 µM) is prepared the same way using 25 µM as the stock.
Six to eight concentrations should be prepared for an affinity / kinetic assay.
The total volume for each dilution is 500 µl, which can be divided into 3 tubes with
150 µl each.

Tips:
_ Samples in 100% DMSO should be kept in glass vials and tightly capped.

_ Certain plastics release contaminants into DMSO that have been observed to bind to
human serum albumin and interfere with binding assays. DMSO is incompatible with
polycarbonate, but is compatible with polypropylene.
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2. SOLVENT CORRECTION
(Reference: “A calibration routine to improve the interpretation of low signal levels and low affinity
interactions” Hakan Roos, Robert Karlsson, and Karl Andersson, Biacore AB)

The SPR signal reflects changes in refractive index (RI) as a result of increases in mass at
the sensor surface. If the injected sample has a RI different from that of the running
buffer an additional signal is obtained known as the bulk refractive index, also referred to
as a solvent effect.  The solvent effect can usually be removed by subtracting the
reference flow cell from the active flow cell when the solvent effect is small (~100 RU).
However, in most small molecule assays where DMSO is used as the solvent, the
subtraction of the reference response does not eliminate the contribution of the solvent to
the measured response because a higher DMSO bulk response will be obtained from the
reference surface.  Bulk solution is excluded from the volume occupied by ligand
molecules on the ligand spot, so the bulk contribution to the relative response is smaller
than on the reference spot (Figure 2.1).

Figure 2.1

The difference is small (usually less than 10 RU) but it can be of the same order of
magnitude as the responses expected from binding of low molecular weight lead
compounds.

Reference surface Ligand surface

Response on
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Response on
ligand surface

Excluded
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2.1 Is Solvent Correction Necessary?

Solvent correction is necessary under a combination of three circumstances that
commonly arise when working with low molecular weight analytes such as drug
candidates:

·  The expected analyte responses are low.
·  The ligand is a macromolecule immobilized at a high density on the surface (typically
     10,000 RU or more).
· The absolute bulk response is high (typically 30,000 RU or more) and is subject to
     variations between sample solutions.

The combination of these three factors results in variations in the magnitude of the
excluded volume effect that are significant in relation to the measured analyte response.

In drug discovery and development work, the analytes are often small molecules that give
correspondingly low response values (typically of the order of 50-100 RU or less). High
levels of immobilized ligands (several thousand RU) are used to maximize the analyte
response. Addition of DMSO to samples and buffers gives a high bulk response. A
difference of 1% in DMSO concentration corresponds to a difference of ~1200 RU in
bulk response, so that small variations in DMSO concentration, unavoidable in the
preparation of a large number of diverse samples, lead to significant differences in bulk
response between samples. Solvent correction samples should generally be included in
assay protocols for this kind of work: the decision as to whether to apply the solvent
correction or not can be made when the results are evaluated. If data is collected during
the dissociation phase, DMSO bulk responses are not an issue and the data may be
handled by conventional reference subtraction.

Figure 2.2
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2.2 Solvent Correction Procedure

The following procedure is a suggested protocol that uses 5% DMSO in samples and
running buffer. Adjust the amounts and concentrations accordingly if a different DMSO
concentration is being used. Prepare all solutions containing DMSO fresh each day.

1. Prepare a PBS buffer stock solution at 1.05X final concentration. (see section 1.1)
2. Prepare solvent correction solutions over a range of DMSO concentrations from 4.5%

to 5.8% by adding100% DMSO to 1900 µl aliquots of 1.05X buffer. The table below
gives suggested volumes for 8 solvent corrections solutions.

3. Use these solutions for the solvent correction cycles in the assay procedure. The
solutions should be freshly prepared for each assay.

Tips:
_ Do not store DMSO in plastic vessels. Make sure that all plastic equipment used in
handling the solutions is resistant to DMSO. Use teflon or nylon membranes to filter
DMSO solutions: do not use cellulose acetate membranes.

_ Prepare all solutions carefully. Any mismatch in composition except for the DMSO
concentration will affect the accuracy of the solvent correction.

_ The exact DMSO concentrations in the solutions are not crucial, but it is important that
the solutions cover an adequate range of bulk responses. If the range is too narrow, it may
not be possible to correct the assay results for solvent effects.
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2.3 Applying Solvent Correction

Solvent correction is applied to assay results in the evaluation software, after the assay is
completed.  The following instructions are for applying solvent correction data to an
assay performed on a Biacore 2000 or 3000 using BIAevaluation 3.0 or higher.

Generate a DMSO Calibration Curve
1. Open the file in BIAevaluation  and choose Rpoint table only.
2. Extract the calibration data by selecting Data>filter. Under the Fc column choose the

reference flow cell and under the Id column choose Bulk.  The control flow cell and
the Id for the calibration samples will depend on the user-defined method.

3. Once the data has been filtered for the control flow cell and the calibration solutions,
copy and paste columns Cycle and RelResp into a new sheet by selecting File>New
sheet.

4. Return to the window containing the original Rpoint table and filer the data to select
the active flow cell and calibrators should still be under the Id column.

5. Once the data has been filtered for the active flow cell and the calibration solutions,
copy and past RelResp to same sheet created in Step 3.

6. Change RelResp column headings to Fc 1 and Fc 2 and name the next empty column
Fc 2-1.

7. In the Fc 2-1 column subtract Fc 1 from Fc 2 using the same method used in Excel.

EXAMPLE:
Cycle Fc1 Fc2 Fc2-1
1 384.2 376.1 -8.1
2 181.9 177 -4.9
3 80 76.7 -3.3
4 -22.3 -24 -1.7
5 -127.3 -127.5 -0.2
6 487.3 476.6 -10.7
7 583.2 569.8 -13.4
8 279.4 272.9 -6.5

8. Select Data>Generate Calibration, set X Keyword Fc 2-1, Y Keyword Fc1. Choose
Other and Line under Fitting Function.

9. View the calibration curve (example shown below) and determine if the fit is good.
The fit may be improved by removing points that lie outside the range of sample bulk
responses.
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Figure 2.3

Correct Sample Bulk Responses
1. Return to the Rpoint table.
2. Filter for the reference flow cell and under Id column choose Plateu.
3. Copy and Paste columns Cycle and RelResp to sheet used to generate calibration

curve.
4. Return to the Rpoint table.
5. Filter for the reference flow cell and under Id column choose Plateu.
6. Copy and Paste RelResp to sheet used to generate calibration curve.
7. Change RelResp column headings to Drug Fc1 and Drug Fc2.
8. To find the correction factor choose Data>Calculate values>Next.
9. Set Y keyword=Drug Fc1 (the samples bulk response in the reference flow cell).

Click Finish.
10. Give the new column the heading Corr, and next column heading True.
11. In the True column subtract: Drug Fc2-Drug Fc1-Corr .

Repeat process for flow cells 3 and 4 substituting the data from Fc 3 and Fc 4 for both the
calibration curve and correction of drug binding response.  Using a new sheet for each
flow cell is recommended.
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3. EXPERIMENTAL PROCEDURE

3.1 Method for Screening

The following MDL instructions are for performing the assay on Biacore 2000 or 3000.

MAIN
RACK 1 Thermo_A
RACK 2 Thermo_C

NORMALIZE r1a1
PRIME

   PRIME
   PRIME
   PRIME
   PRIME
FLOWCELL   1,2,3,4
LOOP SAMPLES ORDER
    APROG      SCREEN %POS %ID %CONC
ENDLOOP
  APPEND     STANDBY
END

DEFINE APROG SCREEN
  PARAM %POS %ID %CONC
       FLOW       50
FLOWPATH   1,2,3,4
    *  KINJECT    r1a2 50 1              !BLANK BUFFER INJECTION

-0:20 RPOINT     -B BASELINE     !TO CHECK FOR CARRY-OVER.
 1:20 RPOINT     CARRYOVER
    *  KINJECT    %POS 50 60
       EXTRACLEAN
-0:20 RPOINT     -B BASELINE
 0:50 RPOINT     BULK
 1:10 RPOINT     DISS1
 1:40 RPOINT     DISS2
END
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DEFINE LOOP SAMPLES
LPARAM  %POS   %ID          %CONC
TIMES 2

r2a1   BUFFER       0    !RUN 10 BUFFER INJECTIONS AT THE BEGINNING
r2a2   BUFFER       0    !OF THE SCREEN TO STABILIZE THE SYSTEM.
r2a3   BUFFER       0
r2a4   BUFFER       0    !THROUGHOUT THE SCREEN, INCLUDE BLANK
r2a5   BUFFER       0    !BUFFER INJECTIONS TO BE USED IN THE
r2a6   BUFFER       0    !DOUBLE REFERENCING.
r2a7   BUFFER       0
r2a8  BUFFER       0
r2a9   BUFFER       0
r2a10  BUFFER       0
r2b1   CALIBRATION  1    !RUN CALIBRATORS EVERY 20 SAMPLES.
r2b2   CALIBRATION  2
r2b3   CALIBRATION  3
r2b4   CALIBRATION  4
r2b5   CALIBRATION  5
r2b6   CALIBRATION  6
r2b7   CALIBRATION  7
r2b8  CALIBRATION  8
r2c1   compound_1   10uM
r2c2   compound_2   10uM
r2c3   compound_1   100uM
r2c4   compound_2   100uM

END

3.2 Report Points

                       2
                                                         

                      3                                                        -

1                    4          5        6

         SAMPLE                 BUFFER

1- sample baseline
2- bulk response, (binding level)
3- dissociation 1, (stability early)
4 -dissociation 2, (stability late)
5- carry-over baseline
6- carry-over control
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4. DATA EVALUATION

References:

A. Frostel-Karlsson, A. Remaeus, H. Roos, K. Anderson, P. Borg, M.
Hamalainen, R. Karlsson (2000) Biosensor Analysis of the Interaction between
Immobilized Human Serum Albumin and Drug Compounds for Prediction of Human
Serum Albumin Binding Levels. Journal of Medicinal Chemistry, 43, 1986-1992.

Data evaluation and analysis are report point - based. All plots can be constructed in
Excel.

4.1 Quality Control Plots

1. Baseline stability
Plot the baseline report point (report point 1) versus cycle number. This should be done
using raw data, i.e. the data should not be Y-transformed, reference subtracted, molecular
weight corrected or solvent corrected.

2. Carry-over
Plot the carry-over report point (report point 6) versus cycle number. The data should be
Y-transformed to beseline-zero, reference subtracted and solvent corrected.

3. Binding to control surface
Plot the bulk response (report point 2) versus cycle number for Fc 1, reference flow cell.
The data should be raw data, i.e. not reference subtracted, Y-transformed or solvent
corrected.

4. Control binding levels
Plot the bulk response (report point 2) for positive and negative control compounds
versus cycle number for Fc 2, experimental flow cell. The data should be  Y-transformed,
reference subtracted, solvent corrected and not molecular weight corrected.

Generate these Quality Control Plots for the Fc 2, experimental flow cell, using the Fc 1
surface as the reference.

4.2 Data presentation and analysis
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Plot the following versus cycle number for all compounds. All data should be Y-
transformed to baseline-zero, reference subtracted, solvent corrected and molecular
weight corrected.
• Bulk response (binding level), report point 2
• Dissociation 1 (stability early), report point 3
• Dissociation 2 (stability late), report point 4

Plot bulk response (report point 2) versus dissociation 1 (report point 3) or dissociation 2
(report point 4) depending on the magnitude of the off rates in the data set.

For “hits” found during the experiment, a compound characterization (kinetics) run can
be performed. The kinetic data is summarized in a  kon versus koff  plot, where lines are
drawn representing constant affinity, KD, values.

Set “Hit” Criterion. Often control compounds can be used to define hits as “high” or
“low” binders. Also groups of compounds may be evident on bulk response (report point
2) versus dissociation 1 (report point 3) plots.

For fast kinetic interactions, where dissociation 1 (report point 3) may not contain useful
values, rank compounds by Req values, bulk response (report point 2) at same analyte
concentration.


